
R. Greene CNMI BECQ August 2017 

BECQ 2017 SLR Map Layer Updates: Methodology for Coastal Flood Geoprocessing 

 

This paper summarizes the local and regional sea level data used to develop coastal flooding scenarios 

for the island of Saipan, CNMI, and outlines the basic geospatial processing steps used to derive spatial 

data for six of those scenarios.  This document is an update to the original “Saipan SLR Mapping 

Methodology”, which was appended to the Saipan Climate Vulnerability Assessment (2014). 

Since the publication of the Saipan Climate Vulnerability Assessment in 2014, the primary means of 

assessing Saipan’s exposure to changes in sea level has been through a simple coastal flooding mapping 

approach.  Inundation and flood mapping required data processing and analysis using Geographic 

Information Systems (GIS).  Geospatial data layers for sea level change (SLC) and rise (SLR) scenarios, 

in the form of raster and vector data types, have been developed using ESRI ArcGIS 10.x software. 

Geoprocessing methods were originally developed by NOAA Coastal Services Center (see document 

“Detailed Methodology for Mapping Sea Level Rise Inundation” NOAA CSC, 2011).  The NOAA 

methods were modified and applied to sea level data specific to the Mariana Islands. 

It should be noted that several elements of the mapping approach introduce significant limitations and 

caveats to exposure analysis.  While these limitations present obstacles to visualizing accurate 

representations of future conditions, they also offer opportunities for enhanced modeling as inundation 

scenarios on Saipan continue to be studied.  Enhanced efforts could integrate more detailed hydrologic 

features, updated elevation and shoreline positions, or adopt numerical models that incorporate wave 

run-up and other coastal processes.  

For the 2017 SLR Mapping update, a modified bathtub model has been utilized, which allows for 

mapping of changes in still-water levels over a high-resolution, conditioned digital elevation model. The 

bathtub approach does not consider future changes in shoreline due to coastal processes such as erosion 

and accretion, nor does it account for wave run-up or the influence of certain hydraulic features such as 

stormwater/sewer infrastructure. A detailed comparison of the bathtub approach to a dynamic, numerical 

wave run-up model is provided in USGS Open Report 2013-1069 (Storlazzi, et al. 2013). 

Sea Level Scenarios and Data Sources 

The 2017 updates to the Saipan SLR & Coastal Flooding maps resulted in 6 new spatial data layers 

reflecting increased future sea levels due to both climate change-driven processes (referred to as SLR), 

as well as seasonal extremes estimated for a 100-year return period (referred to as SLC).  Both drivers of 

sea level rise/change were analyzed using local and regional data, primarily from Saipan & Guam tide 

gauges. These scenarios are detailed on the following pages.  
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SLC Scenarios Due to Seasonal Sea Level Extremes (Chowdury et al, 2010) 

SLC scenarios based on seasonal sea level extremes were derived from Chowdhury et al.’s (2010) statistical 

modeling of 20 and 100-year return periods & monthly maximum data from 1978-2003 on Saipan.  This study 

leveraged a more robust and locally relevant set of input data than the USACE Typhoon Surface Water Analysis 

for Saipan Lagoon (Chou, L. 1989), which was used as a data source in BECQ’s previous flood mapping efforts.  

For BECQ’s purposes of mapping sea level changes and extremes for Saipan, the 1989 USACE modeling can be 

considered superseded by Chowdhury et. al’s analysis (see table below). 

 
Table from Chowdhury, et. al, 2010 

 

Sea level extremes for the months of October, November, and December (OND) at the 100-year return period 

were used in BECQ’s 2017 mapping updates.  This resulted in a base sea level of +0.628 meters above datum.   

BECQ’s “extreme scenario” utilized the same return period with OND values during years in which typhoons 

skewed the sea level values on Saipan (bold in table above).  While this data is technically “skewed”, it is also 

representative of what Saipan could expect during a year in which a typhoon passes in close proximity to the 

island or makes landfall. The OND sea levels during an “extreme” or “typhoon year” could reach +1.846 meters. 

Additional information regarding these seasonal extreme values can be found in the paper: 

Chowdhury, Md. R., Chu, P., Zhao, X., Schroeder, T.A., and Marra, J.J. (2010). Sea level extremes in the U.S.-

Affiliated Pacific Islands—a coastal hazard scenario to aid in decision analyses. Journal of Coastal 

Conservation. 14:1, pp 53-62. 
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SLR Scenarios Due to Climate Change 

Sea level rise projections for Saipan were based on revisions to two primary resources: 2017 updates to 

NOAA sea level trend analyses (Sweet, W.V. et. al. (2017).Global and Regional Sea Level Rise 

Scenarios for the United States. NOAA Technical Report NOS CO-OPS 083.) and the 2017 update to the 

U.S. Army Corps’ Sea Level Curve Calculator (http://corpsclimate.us/ccaceslcurves.cfm). 

Future sea levels were calculated using the “NOAA High” curve as the projection basis for the USACE 

Curve Calculator.  The NOAA High Curve assumes a “business-as-usual” greenhouse gas emissions 

scenario through the end of the century (Representative Concentration Pathway 8.5 from the 

International Panel on Climate Change 5th Assessment Report, 2014) in which carbon emissions are not 

substantially curbed, and initial contributions of Antarctic ice melt are factored in.  Details concerning 

these computations and associated probabilities are available in Sweet et al., 2017. 

The USACE Curve Calculator further refines these calculations by factoring in local vertical land 

movement at tide gauges with complete records for the current tidal epoch.  The Apra Harbor tide gauge 

on Guam contains the most thorough sea level records for the Marianas, and was therefore used as a 

proxy for Saipan in these calculations. 

A table and graph illustrating the lower and upper bounds of Marianas sea level projections are included 

on the following page.  NOAA guidance suggests selection of scenarios for coastal planning and 

decision making based on the relative risk of the systems that are being planned for (e.g. development 

on Saipan’s western coastal plain), the risk aversion of decision makers and stakeholders (e.g. 

developers’ relative comfort level with certain probabilities of a hazard), and the flexibility or adaptive 

capacity of the system within a given time frame.   

For Saipan, the NOAA High Curve was selected based on the relatively large-scale investments and 

rapid development currently (2016-2017) observed, and the relatively low flexibility or adaptive 

capacity once these developments and investments are put into motion, which include large changes to 

land use and the built environment along coastal flood plains, as well as substantial investments in 

island-wide infrastructure and public works. 

In addition, lifespans for buildings, utilities, and water resources range from 30 years to 75 years, with 

projects often being bounded by 55 year land leases.  The largest structures to have ever been built in the 

CNMI may aspire to life spans surpassing the 75 year horizon, while materials used in public works 

projects may require upgrades or replacement in as little as 25 years.  Considering this planning 

envelope, mapping scenarios were built off of 30, 50, and 75 year projections. 

http://corpsclimate.us/ccaceslcurves.cfm
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Detailed documentation concerning these calculations can be found in USACE Circular 1165-2-2012 

(http://corpsclimate.us/docs/EC_1165-2-212%20-Final_10_Nov_2011.pdf ) and on the USACE Sea Level 

Change website: http://corpsclimate.us/ccacesl.cfm . 

 

 

http://corpsclimate.us/docs/EC_1165-2-212%20-Final_10_Nov_2011.pdf
http://corpsclimate.us/ccacesl.cfm
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Combining the October-November seasonal sea level extreme estimates for 100-year recurrence at Saipan Harbor 

with the USACE Sea Level Curve Calculator/NOAA 2017 Projections, the following scenarios were computed and 

mapped: 

 

    

Scenario Data Code

Seasonal 

Extreme 

(meters)

Seasonal Extreme Description*
Sea Level 

Rise (m.)
Sea Level Rise Description**

Cumulative 

Sea Level 

Change (m.)

OND Seasonal 

Extreme (Typhoon 

Year)

OND_TY 1.85

Historically derived (1978-2003) maximum 

sea level for 100-year recurrence at Saipan 

Harbor, during the months of October - 

December including data from years with 

typhoon passage.

0
Climate change-related sea level rise 

not factored into this scenario.
1.85

50 years SLR SLR50 0
No seasonal extreme estimates factored 

into this scenario.
1.31

Sea level rise projection for 2067 

based on NOAA 2017 "High" curve 

and U.S. Army Corps sea level curve 

calculator for Apra Harbor tide 

gauge (local vertical land movement)

1.31

30 years SLR + 

OND Seasonal 

Extreme

SLR30_OND 0.63

Historically derived (1978-2003) maximum 

sea level estimate for 100-year recurrence 

at Saipan Harbor for months Oct.-Dec., with 

Typhoon-affected data removed.

0.74

Sea level rise projection for 2047 

based on NOAA 2017 "High" curve 

and U.S. Army Corps sea level curve 

calculator for Apra Harbor tide 

gauge (local vertical land movement)

1.37

50 years SLR + 

OND Seasonal 

Extreme

SLR50_OND 0.63

Historically derived (1978-2003) maximum 

sea level estimate for 100-year recurrence 

at Saipan Harbor for months Oct.-Dec., with 

Typhoon-affected data removed.

1.31

Sea level rise projection for 2067 

based on NOAA 2017 "High" curve 

and U.S. Army Corps sea level curve 

calculator for Apra Harbor tide 

gauge (local vertical land movement)

1.94

75 years SLR + 

OND Seasonal 

Extreme

SLR75_OND 0.63

Historically derived (1978-2003) maximum 

sea level estimate for 100-year recurrence 

at Saipan Harbor for months Oct.-Dec., with 

Typhoon-affected data removed.

2.14

Sea level rise projection for 2093 

based on NOAA 2017 "High" curve 

and U.S. Army Corps sea level curve 

calculator for Apra Harbor tide 

gauge (local vertical land movement)

2.77

50 years SLR + 

OND Seasonal 

Typhoon Year

SLR50_ONDTY 1.85

Historically derived (1978-2003) maximum 

sea level for 100 year recurrence interval at 

Saipan Harbor, during the months of 

October - December including data from 

years with typhoon passage.

1.31

Sea level rise projection for 2067 

based on NOAA 2017 "High" curve 

and U.S. Army Corps sea level curve 

calculator for Apra Harbor tide 

gauge (local vertical land movement)

3.16

2017 Saipan Coastal Flood Mapping Updates: Scenario Descriptions

* See Chowdhury, Md. R., Chu, P., Zhao, X., Schroeder, T.A., and Marra, J.J. (2010). Sea level extremes in the U.S.-Affiliated Pacific Islands—a coastal hazard 

scenario to aid in decision analyses. Journal of Coastal Conservation. 14 :1, pp 53-62.

** See http://corpsclimate.us/ccaceslcurves.cfm (Revised 2017) and  U.S. Army Corps of Engineers. (2011). Sea Level Change Considerations for Civil Works 

Programs. U.S. Army Corps Circular 1065-2-212. http://corpsclimate.us/docs/EC_1165-2-212%20-Final_10_Nov_2011.pdf
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Mapping Methods 

Inputs:  

• Digital Elevation Model (DEM) 

- The DEM for Saipan is based on 2007 USACE high-resolution lidar data. Hydrographic breaklines in 

the DEM were derived from lidar intensity images, and the DEM is hydro-flattened so that water 

elevations are set to 0 meters. 

- Source lidar has a horizontal accuracy of 1 meter, and vertical accuracy root mean square error of 20 

cm.  DEM resolution is 2.69 meters. The source data meets FEMA standards for flood hazard 

mapping. 

- DEM was conditioned and distributed by NOAA CSC. Metadata for the DEM, including process 

steps and software used is available upon request to CNMI Coastal Resources Management Office. 

   

• Tidal surface in NAVD88 values 

- NOAA methodology suggests the use of VDATUM software to develop a tidal surface that captures 

spatial variation in water levels. The VDATUM tool and associated data packages did not include 

coverage of the CNMI at the time that SLC layers were developed, and therefore was not used.  The 

alternative recommended method for creating a tidal surface involves interpolation of sea level values 

at different tide gauges within the area of interest.  Saipan has only one tide gauge, therefore a single 

value tidal surface was generated. 

  

• Sea level change values 

- Values (in meters) for each of the SLC scenarios are described on the previous page of this document. 

 

Workflow in ESRI ArcGIS Desktop 
(as detailed by NOAA CSC SLR Inundation Mapping Whitepaper) 

Note: While the following workflow was completed for the six coastal flooding scenarios, only the connected 

depth grid (step 7) and an associated polygon for each scenario was exported and published in a file 

geodatabase to the BECQ Server.  The polygons for each scenario were also merged into a single feature, 

and published to the BECQ online data portal, providing the primary means of public access to visualize 

and download the data as a single file. 

1. Add SLC value to the tidal surface grid  

 

Spatial Analyst > Math > Plus  

- Input raster or constant value 1 = tidal surface  

- Input raster or constant value 2 = SLC value for OND_TY  

- Output raster = surface_OND_TY 

 

2. Subtract DEM values from water surface to derive initial inundation depth grid  

 

Spatial Analyst > Single Ouput Map Algebra  

- Map Algebra expression: con(DEM <= surface_OND_TY, surface_OND_TY – DEM)  

- Output raster = depth_ OND_TY  

 

3. In preparation for evaluating connectivity, create single value DEM to show inundation extent  

 

Spatial Analyst > Single Output Map Algebra  

- Map Algebra expression: con(DEM <= surface_OND_TY, 1)  
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- Output raster = single_ OND_TY 

 

 

4. Evaluate connectivity of extent raster  

 

Spatial Analyst > Generalization > Region Group  

- Input raster = single_OND_TY  

- Number of neighbors to use = 8  

- Zone grouping method = Within  

- Output raster = clumped_OND_TY  

 

5. Extract connected inundation surface to be used as a mask for the original depth grid  

 

Spatial Analyst > Extraction > Extract by Attributes  

- Input raster = clumped_OND_TY  

- Where clause: “Count” = maximum value  

- Output raster = connect_OND_TY 

 

6. Derive low-lying areas greater than an acre  

 

Spatial Analyst > Extraction > Extract by Attributes  

- Input raster = clumped_OND_TY  

- Where clause: “Count” > 40 

- Output raster = lowlying_OND_TY 

*For Saipan*   

- The value of 40 is based on the use of 10 meter grid cells (1 acre = 4046.85m2, 4046.85 m2 / 100 m2 = 40.46). 

 - The DEM has ~3 meter cells, therefore ‘Count’ value was 450 (1 acre = 4046.85m2, 4046.85 m2 / 9 m2 = 

449.65) 

 

7. Create depth grid for connected areas  

 

Spatial Analyst > Extraction > Extract by Mask  

- Input raster = depth_OND_TY  

- Input raster or feature mask data = connect_OND_TY  

- Output raster = con_depth_OND_TY 

 

Additional steps for Saipan 

To derive polygons with “con_depth_OND_TY” values (for additional analysis using feature-based queries, etc…) 

Convert from floating point raster to polygon without losing significant figures (to the third decimal) 

Spatial Analyst -> Map Algebra 
- Int([con_depth_OND_TY]*1000) or Int([Susupe_OND_TY]*1000) 
- New Raster has whole integer values that are 1000 times larger than original depths 
- Output Raster = integer_OND_TY 
Conversion Tools -> From Raster -> Raster to Polygon 
- Input raster: integer_OND_TY 
- Field = ‘value’ 
- New Polygon = OND_TY_Poly 
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- In OND_TY_Poly: Create new depth field to match original floating raster values 
- In attribute table for OND_TY_Poly, Create new field “depth”, field type ‘double’  
- Field Calculator: “depth” = ‘grid_code’/1000 
 
To create single polygons for quick display of inundation extend, excluding flood depth values 
 
Cartography Tools -> Generalization -> Aggregate Polygons OR ‘Dissolve’ based on new field with single value 
- Input: OND_TY_Poly 
- Distance: 0.5 meters (other search distances will work, but must be less than original raster cell resolution to 
avoid aggregation across areas that are not inundated) OR Dissolve based on attribute field with single value 
- Output: OND_TY_Aggregate OR Dissolve 
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